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Map Algebra Exercise (Beginner) – ArcView 9 

 
1.0 INTRODUCTION 
The location of the data set is eastern Africa, more specifically in Nakuru District in Kenya (see 

Figure 1a).  The Great Rift Valley runs through the study area from the northwestern corner down 

to the southeast (the flatter light blue area noted in Figure 1b). 

 

  
Figure 1a: Kenya, Nakuru is east of Lake 

Victoria
1
. 

Figure 1b: Relief of study area. 

 

Use Google Earth to “fly to”: nakuru rift valley (copy/paste bold text to the “fly to” box). If you 

zoom out to an „eye alttitude‟ of ~1,000 km (see bottom right corner of screen for altitude), you 

will see an image that roughly matches Figure 1a.  If you zoom to an altitude of ~250 km you will 

see the area in Figure 1b (the dark green area between Kericho and Nakuru is the Great Rift 

Valley indicated in light blue in Figure 1b). 

 

The analytical aim of this tutorial is to create an agro-climatic zone map of the study area.  The 

map will capture two parameters of interest: moisture availability and temperature.  Moisture 

availability is calculated as the ratio between precipitation and evapotranspiration (i.e. moisture 

availability = precipitation / evapotranspiration).  This is a moderately sophisticated exercise in 

classification, utilizing two parameters.  The three data sets provided are Nrelief (elevation), 

Nrain (precipitation) and Evapo (evapotranspiration, a measure of moisture demand).   

 

The educational aim of this tutorial is to:  

- re-enforce the processes of  setting up a project and examining the data provided, 

- demonstrate the value of cartographic modeling, and 

- further develop skills in conducting raster functions (Reclassify & Raster Calculator) 

 

Typographic notation: a bullet indicates that action is required on your part, i.e. 

 

 Turn the page and begin the tutorial. 

                                                 
1
 Lonely Planet, http://www.lonelyplanet.com/mapshells/africa/kenya/kenya.htm 

Great Rift 

Valley 
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Estimated time to complete this lab: 45 minutes 

 

2.0 INITIAL PROJECT SET-UP 

 

2.1 Copy Data 

The data for this project is in the folder Algebra, which contains within 4 subdirectories: 

Evapo, Nrain, Nrelief, and info.  You will need to copy the Algebra folder to an 

appropriate drive.  

 

 Copy the Algebra folder from G:\ drive to your student U: drive. 

 

2.2 Starting a New Project and Adding Data 

 

 Start ArcMap. 

o Click the radio button for A new empty map 

o Click the Immediately add data check box 

 

 
 

o Click OK 

 

The Add Data window appears. 
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o If necessary “connect to” your Algebra folder (on your U:\ drive).  

 

o Select your working folder (i.e. U:\Algebra) 

o Click once on the  data file evapo 

o Hold down the Shift key and select nrelief … all 3 files should be 

highlighted 

 

 
 

o Click Add 

 

This data was converted from Idrisi and it lacks some spatial reference information and 

therefore cannot be converted to different projections.  An error message appears. 

 

 
 

 Click OK 

 

The Table of Contents section on the left side of the window should list the three map 

layers – all with a black-white colour ramp. 

 

2.3 Enabling Spatial Analyst 

As we will be working with raster grids we will need to „turn on‟ the Spatial Analyst 

module.  Spatial Analyst may already be „turned on‟ – if so the toolbar will be visible.   
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If Spatial Analyst is not turned on then conduct the following steps, otherwise skip to 

section 2.4. 

 

 From the Tools menu select Extensions 

o Click the Spatial Analyst check box and click the  button 

 

 
 

Even though we have loaded the Spatial Analyst extension, its menu is not activated.  To 

activate the Spatial Analyst menu … 

 

 From the View menu select Tools and then select Spatial Analyst 

 

The Spatial Analyst menu will appear on its own bar below the menu.  This menu 

consists of four parts: a drop-down analysis menu, a combo-box for choosing the raster 

layer, a contour tool and a histogram tool. 

 

  
 

 

2.4 Setting the Working Directory 
To ease file management we will set the working directory to the same directory as our 

data (U:\Algebra).   

 

 Click on the Spatial Analyst drop-down menu 

o Select Options 
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o Ensure the General tab is selected and browse to the appropriate directory 

(i.e. U:\Algebra) – note, you start browsing by clicking the folder button 

on the right side 

 

  
 

o Click OK 

 

 

2.3 Saving the Project 

Next we will name and save this project. 

 

 From the File menu select Save As 

o Navigate to the appropriate directory (i.e. U:\Algebra) 

o Type in an appropriate project name (i.e. MapAlgebra) 

 

  

U:\Algebra 
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o Click  

 

The project has now been created and has the source data added. 

 

3.0 EXPLORING THE DATA 

When first starting out on a project it is a good idea to explore the data and alter how it is 

displayed in order to better understand the information in the various layers.  Note that: 

1. the pixel resolution is 250 metres 

2. the values for elevation are in feet and  

3. the units for rainfall and evapotranspiration are in millimeters. 

 

3.1 Altering the Display of the Data 
We will now alter the display to make the data more intuitive. 

 Ensure that only nrelief is checked in the table of contents (otherwise nrain or evapo 

may be drawn overtop of the nrelief layer) 

 Double click on nrelief in the table of contents 

o Select the Symbology tab 

o Click the Color Ramp drop-down box and choose a desired color scheme 

(suggested scheme can be selected by clicking the down arrow 11 times – this 

should access a color ramp good for elevations – it is green on the left, brown 

in the middle and purple-white on the right – select it). 

o Click OK 

 

The low elevation valley bottom is light green and higher elevations are light purple to 

white.  Note with gentle slopes the color gradually fades from one color to another 

whereas steep areas have abrupt colour changes.   

 

Let‟s pick a color scheme that is more intuitive for the rainfall data, e.g. where drier areas 

are light blue and wetter areas are dark blue.   

 

 Ensure there is a check mark beside nrain 

 Double click on nrain in the table of contents 

o Select the Symbology tab 

o Click the Color Ramp drop-down box and choose a blue color scheme (light 

blue on left and dark blue on right))  

o Click OK 

 

Remember that lighter areas are drier and darker areas are wetter.  Try to determine if 

there is a relationship between elevation and mean annual rainfall.  You can casually do 

this by … 

 

 keep the nrelief map layer on, and then turn on and off the display of the nrain 

map layer. 
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Indeed there appears to be a directly proportional relationship between the two variables, 

such that mean annual rainfall increases with elevation.   

 

Evapo (a.k.a. evapotranspiration, which is a measure of moisture demand) is another 

climatic parameter that is proportional to elevation.  Try to determine if there is a 

relationship between elevations and evapotranspiration.   

 ensure that nrain is “off” 

 keep the nrelief map layer on, and turn on and off the display of the evapo map 

layer. 

Where is there greater moisture demand, the valley bottom or hilltops? 

 

4.0 CONDUCTING THE ANALYSIS 
Assessing the landscape for suitability for growing crops usually involves an assessment 

of temperature and moisture availability.  Typically it is far easier to evaluate the 

landscape for temperature and moisture availability if the data have been simplified 

(generalized).  Thus, both of these factors will be generalized into zones.  The value 

ranges for these moisture availability and temperature zones are given in tables 1 and 2, 

respectively.   

 

Table 1: Moisture Zones       Table 2: Temperature Zones 

Range of 

Values 

Moisture 

Availability 

Zone 

 Range of 

Values 

Temperature 

Zone 

     0 – 0.15 7  0 – 10 9 

0.15 – 0.25 6  10 – 12 8 

0.25 – 0.40 5  12 – 14 7 

0.40 – 0.50 4  14 – 16 6 

0.50 – 0.65 3  16 – 18 5 

0.65 – 0.80 2  18 – 20 4 

0.80 – 1.10 1  20 – 22 3 

   22 – 24 2 

   24 – 99 1 

 

These moisture and temperature zones are utilized for agriculture suitability analysis in 

Africa.  You should be aware that some of these classes may not „apply‟ to our data set.  

That is, some of the classes may represent areas that are hotter, colder, drier or wetter 

than the area contained within our study area. 

 

The end result of our analysis will be the creation of a climatic zone map that combines 

these moisture and temperature zones.  Obviously before we create our final climatic 

zone map we will need to create a moisture zone map and a temperature zone map.  

Figure 2 shows this portion of our analysis. 
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This cartographic model outlines the final steps required to conduct our analysis.  Note: 

the boxes indicate a data layer (with the units provided in brackets) and the arrow 

indicates an analytical operation (with parameters provided below the arrow).   

 

Unfortunately we don‟t have the Moisture (moisture availability) or Temperature data 

sets – you have to create them.  The only data provided are elevations (Nrelief), mean 

annual precipitation (Nrain) and evapotranspiration (Evapo).   

 

Deriving Moisture Availability 

Moisture availability is the water available to plants.  This is depicted as Moisture in 

figure 2.  It is often expressed as a ratio of rainfall/evapotranspiration (ET).  Consider the 

following: 

if rainfall = 50 cm and ET = 50 cm then the ratio equals 1 (i.e. water is balanced) 

if rainfall = 50 cm and ET = 25 cm then the ratio equals 2 (i.e. water excess) 

if rainfall = 50 cm and ET = 100 cm then the ratio equals 0.5 (i.e. water deficit) 

 

Deriving Temperature 

Creating a temperature layer will actually be quite straightforward as there is a known 

relationship between temperature and elevation.  This relationship is in the form of an 

equation.  

  

Y (temperature ºC) =  –0.0016 X (elevation feet) + 26.985 

 

If the elevation value for any given pixel from the Nrelief layer is plugged into this 

equation we will get the mean annual temperature for that location.  Thus we can create a 

temperature layer by applying an equation to each pixel in the elevation layer.  

 

Using a Cartographic Model 
A complete model of all the steps required to complete this analysis follows in figure 3.  

The numbers over the arrows indicate the operations conducted and are described in the 

accompanying table.  Note that Nrelief, Nrain and Evapo are the only raster layers 

supplied; all other layers are derived from an analytical operation. 

 

 

ClimateZones 

 

(classes) 

MoistZone 

 

(classes) 

TempZone 

 

(classes) 

Moisture 
 

(ratio) 

Temperature 
 

(ºC) 

Figure 2: Cartographic Model 

Reclassify 

 
Use values 

from Table 1 

Reclassify 

 
Use values 

from Table 2 

Raster 

Calculator 

 
Use an 

equation to 

combine these 
two maps into 

one 
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You will find that referring to the cartographic model as you conduct each step will aid in 

understanding where you are in the grand scheme of this multi-step procedure.  The 

cartographic model is reproduced at the end of the tutorial. 

 

 Tear off the last page and use it as a reference as you conduct the analysis (e.g. 

„mark off‟ each step as it is completed). 

 

Note that the cartographic model is provided on the next page for you to ponder.  The 

shaded boxes indicate map layers provided.  The clear boxes are map layers you need to 

create.  If it does not make sense, then ask an Instructor for help.
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Step Function Comment 

1 Raster Calculator Apply equation: Nrain / Evapo 

2 Reclassify Classify data according to Table 1 

3 Raster Calculator Apply equation Y (temperature ºC) =  –0.0016 X (elevation feet) + 26.985 

4 Reclassify Classify data according to Table 2 

5 Raster Calculator Combine the data from both layers 

 

ClimateZones 

 

(classes) 

MoistZone 
 

(classes) 

TempZone 
 

(classes) 

Moisture 
 

(ratio, no units) 

Temperature 

 

(ºC) 

Nrain 

 

(mm) 

Nrelief 

 

(feet) 

Evapo 

 

(mm) 

 

1 2 

3 4 

5 

Figure 3: Complete Cartographic Model 
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Note: for the Raster Calculator it is very important to get the „syntax‟ of the expression 

exact – if not, a “Syntax Error” message will appear.  Syntax errors are usually not 

obvious.  To correct the situation it is easiest to close the Raster Calculator window and 

then reselect it from the menu and begin fresh. 

 

4.1 Creating Moisture (Availability) 
First let‟s create the moisture availability layer.  Remember this is a ratio of precipitation 

/ evapotranspiration.  Thus we have to divide the pixels of one map by those of a second. 

 

 From the Spatial Analyst drop down menu select Raster Calculator 

o Double click on Nrain 

o Click the divide button   

o Double click on Evapo 

 

 
 

o Click the  button 

 

Values displayed in the legend should vary from 0.361 to 1.019.  Next we will rename 

this layer to something more meaningful. 

 

 Right click on the Calculation theme and then select Properties 

o Click the General tab 

o In the Layer Name: box, type Moisture 

o Click OK 

 

This completes step 1 by combining Nrain and Evapo to create Moisture.  Remember that 

lower values indicate drier conditions (less than 1.0 means that the moisture demands are 

greater than the rainfall – drought tolerant plants would be needed). 
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4.2 Creating Moisture Zones 
By reclassifying the values in Moisture according to Table 1 we can create a layer 

depicting moisture zones – this is step 2.  Table 1 is reproduced below. 

 
Table 1: Moisture Zones        

Range of Values Moisture Availability 

Zone 

0 - 0.15 7 

0.15 – 0.25 6 

0.25 – 0.40 5 

0.40 – 0.50 4 

0.50 – 0.65 3 

0.65 – 0.80 2 

0.80 – 1.10 1 

 

 

 

 From the Spatial Analyst drop down menu select Reclassify 

o Click the Classify button on the right side, then select 7 for Classes 

o Refer to Table 1 and enter in the appropriate values under the column 

headings: Old Values and New Values (** Note that the last two rows are not 

shown in the diagram below, although you still need to enter them from 

Table 1). 

 
 

 

o Note that the last range has a value of „1.1‟ entered as the upper limit.  We 

know from the legend that the largest value in the layer is 1.019.  Any value 

larger than this will suffice (e.g. 1.02 or even 99, I just happened to choose 

1.1).   

o Click OK 

 

The resultant layer, Reclass of Moisture, only contains classes of 1 through 5 – there are 

no areas in classes 6 or 7 (no areas are that dry).  The moisture class layer should look 

similar to the following image (colors may vary). 
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To keep consistent with our cartographic model, let‟s rename this layer. 

 

 Right click on the Reclass of Moisture theme and then select Properties 

o Click the General tab 

o In the Layer Name: box, type MoistZone 

o Click OK 

 

 

4.3 Creating Temperature 
For step 4 use the Raster Calculator and apply the equation Y = –0.0016 * X + 26.985 to 

each pixel in the elevation layer to create temperature. 

 

 From the Spatial Analyst drop down menu select Raster Calculator 

o Double click on Nrelief 

o Click the multiply button  

o Type –0.0016 + 26.985 

 

You equation should look as follows 

 

 
 

o Click the  button 
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Values displayed in the legend should vary from 11.236 to 17.878.  Next, rename this 

layer. 

 

 Right click on the Calculation theme and then select Properties 

o Click the General tab 

o In the Layer Name: box, type Temperature 

o Click OK 

 

4.4 Creating Temperature Zones 
By reclassifying the values in Temperature according to Table 2 we can create a layer 

depicting temperature zones.  For the sake of convenience, Table 2 is reproduced below. 

 
Table 2: Temperature Zones 

Range of Values Temperature Zone 

0 - 10 9 

10 – 12 8 

12 – 14 7 

14 – 16 6 

16 – 18 5 

18 – 20 4 

20 – 22 3 

22 – 24 2 

 24 - 99 1 

 

 From the Spatial Analyst drop down menu click Reclassify 

o Click the Classify button on the right side, then select 9 for Classes 

o Refer to Table 2 and enter in the appropriate values from Table 2 under the 

column headings: Old Values and New Values (see following image, note the 

top four ranges don‟t show in this window). 

 

 
 

Note that „99‟ was entered as the upper value in the last range – this just ensures that no 

temperature values are missed in this reclassification.  The resultant layer, Reclass of 
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Temperature, only has temperature classes 5 through 8 – if you consider the temperature 

range for this area, this makes sense.  The temperature zone layer should look similar to 

the following image. 

 

 
 

Again, to keep consistent with our cartographic model, let‟s rename this layer. 

 

 Right click on the Reclass of Temperature theme and then select Properties 

o Click the General tab 

o In the Layer Name: box, type TempZone 

o Click OK 

 

4.5 Creating the Agro-Climatic Zones 
The last step is to combine the moisture and temperature zones into one image.  This 

again is done with the Raster Calculator.  Remember a pixel can only hold one value; 

hence it cannot contain two separate values, one from each image.  This is unfortunate 

because if a pixel location were to have a moisture zone of 4 and a temperature zone of 5, 

it would be nice if the pixel value in the resultant layer had something like 4 : 5.  In this 

way information from both layers would be retained.  One way around this would be to 

multiply the values in the moisture layer by 10, whereby „4‟ becomes „40‟.  Then if we 

were to add the two layers we would get similar results, i.e. 45 instead of 4 : 5.  Provided 

we remember the 10‟s digit place represents moisture and the 1‟s digit place represents 

temperature, we retain the information from both layers. 

 

 From the Spatial Analyst drop down menu click Raster Calculator. 

o From the Layers list double click MoistZone 

o Click the multiply button  

o Type 10 

o Click the  button 
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o From the Layers list double click TempZone 

 

The equation should look like … 

 
 

o Click the  button 

 

There should be 13 values in the legend, ranging from 16 to 55.  The layer should look 

like the following: 

 
 

 

Let‟s rename this final layer. 

 Right click on the Calculation theme and then select Properties 

o Click the General tab 

o In the Layer Name: box, type ClimateZones, then click OK 

 

We have completed the exercise.  Based on known temperature and moisture 

requirements of crop plants and utilizing a map such as this one, agro-planners can create 

crop suitability maps.  Such a suitability map could then be compared to actual crops 

planted to determine if there is any gain to be had from switching crops. 

 

We are finished with this exercise.  Note that all the raster layers you created in this 

exercise are temporary.  To save your completed project … 

 Click on the save button  

 

You are now ready to read the summary below and undertake the lab assignment … 
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5.0 SUMMARY 
As with the previous tutorial, file management is the first issue to address when starting a 

project.  In brief, it is often most convenient to locate all data in one directory (folder).  

This requires three steps: 

1. Create a project directory and copy source data to it, 

2. Set the working directory to this same directory so newly generated data is 

created here, and 

3. Save the project to the same directory. 

 

This was a multi-step analytical procedure, which is typical of many GIS applications.  

Some complex analyses utilize a great many data sets and can have many more times the 

number of steps.  Creating a cartographic model requires the analyst to have a clear 

understanding of the entire procedure at the very outset.  The model itself can then act as 

a „road map‟ for conducting the analysis.   

 

The Reclassify function is fairly straightforward in that raw data can be simplified; in our 

case continuous data (temperature and moisture availability) were put into previously 

defined categories.  The Raster Calculator function served three different purposes:  

1. The first was the application of an algebraic equation to each pixel in a raster 

layer to convert it to a new „form‟ (e.g. from elevation to temperature).   

2. Second, it was used divide the pixel values from one layer by a second layer to 

derive a ratio (i.e. precipitation / evapotranspiration to give a measure of moisture 

availability).   

3. And finally, it was used to combine the data from two layers.   
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Step Function Comment 

1 Raster Calculator Apply equation: Nrain / Evapo 

2 Reclassify Classify data according to Table 1 

3 Raster Calculator Apply equation Y (temperature ºC) =  -0.0016 X (elevation feet) + 26.985 

4 Reclassify Classify data according to Table 2 

5 Raster Calculator Combine the data from both layers 

 

 

Pull off this sheet and use as a reference when conducting the analysis. 

ClimateZones 

 

(classes) 

MoistZone 
 

(classes) 

TempZone 
 

(classes) 

Moisture 
 

(ratio, no units) 

Temperature 

 

(ºC) 

Nrain 

 

(mm) 

Nrelief 

 

(feet) 

Evapo 

 

(mm) 

 

1 2 

3 4 

5 


